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1 About the Documentation 

1.1 About this Document  
This guide provides instructions for performing the following 
operations on stand-alone ChromeleonTM stations:  

• installing / updating Chromeleon 7 and  
required 3rd party software components 

• basic configuration of Chromeleon 7 including  
basic instructions for installing instruments 

• configuring Windows to suit Chromeleon 7  

It also describes: 

• hardware and software requirements for installing Chromeleon 7 

• software and data compatibility with previous Chromeleon 
versions 

If you are installing multiple workstations that will be networked 
together, or adding a station to an existing networked installation, 
please contact the Thermo Fisher Scientific Service for Dionex 
Chromatography Software for support. 

 

 



Chromeleon 7 

Page 2 Installation Guide 

1.2 Document Conventions  
The following formatting is used throughout the document to 
indicate text with special importance. 

 Caution:  Indicates text that must be followed carefully to 
avoid potential problems  

 

Note: Indicates information of special interest. 
 

Tip: Indicates information that will help you to use the software 
more efficiently. 

1.3 Other Documents  
Other documents provided with Chromeleon will help you to learn 
more about the software.  Their scope is described in the 
Document Overview, which is included with the Chromeleon 
installation media in printed form.  The documents are also 
available in electronic form on the installation disk in the 
Documents folder. 

Tip: The Glossary describes Chromeleon-specific terms and 
common abbreviations used throughout the documentation. 
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2 System Requirements / 
Compatibility 

2.1 Licensing Requirements / Compatibility 
In order to use Chromeleon you must have a valid license 
matching the software version you are about to install. 

A Chromeleon 7 license has two components:  
- a hardware component called a USB License Key (dongle), and  
- a License File that contains the license information. 

To activate a valid license, the two components must have the 
same serial number and must be present at the same time. 

You will be asked to insert the License Key and to provide a 
License File during the software installation process (section 5.2). 
If you do not have them at hand, you can also activate a license 
later as described in section 5.5. 

2.1.1 The License Key 
The License Key is a USB device that (together with a matching 
License File) allows Chromeleon software to be used on the 
computer where the License Key is present. 

 Caution: The License Key represents your purchase of 
Chromeleon. Protect it as you would protect any other valuable 
object.  

The License Key can be either a new (light blue) Chromeleon 7 
USB device, or a prior-generation (green) Chromeleon 6 USB 
dongle. 

At the time of delivery, new (light blue) License Keys normally 
contain the corresponding License File.  The License File is 
automatically (without warning) moved to the computer the first 
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time the License Key is connected to a computer where 
Chromeleon 7 is present. 

 Caution: When a light blue License Key is new, do not 
connect it to a computer other than the one where it will be 
used.  If the license file is moved to a wrong computer, the 
license file must be manually moved to the computer where it 
will be finally used. 

2.1.2 The License File 
The License File contains the license information, such as the 
software version and the purchased software options. 

The name of the License File is Chromeleon7_xxxxxx.cmlic, 
where xxxxxx is the serial number of the license. 

Tip: The information below is for reference/troubleshooting only; 
the License File is automatically moved/copied to the 
appropriate location during the setup/license activation. 

The license file is stored in the following location:  

Windows XP:  
C:\Documents and Settings\All Users\Application Data\ 
Dionex\Chromeleon\ 

Windows Vista / Windows 7:  
C:\ProgramData\Dionex\Chromeleon\ 

Note: The paths above contain folders that are hidden by 
default.  If you need to see them, follow instructions in Windows 
Help on how to display hidden files and folders. 

2.1.3 License Key (Dongle) Compatibility  
Chromeleon 7 has a different licensing mechanism compared to 
Chromeleon 6.8 and older releases, including all PeakNet 6 
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releases. It still uses a USB License Key (dongle), but instead of 
using a key code, Chromeleon 7 requires installation of a matching 
License File.  

The most recent generation of Chromeleon 6 License Keys (green 
USB dongles) can be used with Chromeleon 7, when a matching 
License File is available. 

2.1.4 License File Compatibility  
Chromeleon 7 License Files are bound to main versions of 
Chromeleon. For example a License File that was provided with 
version 7.0 will support 7.0 SR1, but will not work with version 7.1. 
For the latter an upgrade must be purchased. The updated 
License File will be provided with the upgrade. 

2.2 Supported Chromatography Instruments 
and Modules  

Chromeleon 7 provides full control of most of the current Dionex 
instruments.  In addition, some third party instruments are also 
supported.  For details, please refer to the List of Supported 
Instruments in the Documents folder of the installation disk. 

2.2.1 Firmware Requirements  
The List of Supported Instruments (in the Documents folder of the 
installation disk) lists the firmware versions recommended for 
using various instruments with Chromeleon 7.1 SR1. 

2.3 PC Hardware Requirements  
The table below shows the minimum and the recommended PC 
configuration for a stand-alone installation of Chromeleon 7.1 
SR1.   
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PCs meeting minimum requirements may be sufficient for some 
low-demand applications, but will not provide satisfactory 
performance in many applications.  PCs meeting recommended 
requirements should be suitable for general applications.  

P roces s or Minimum: 2.0 GHz Intel® Pentium® 4 
  class 
With 1 DAD-3000RS: 3 GHz Intel Core® 2 Duo  
With 2 DAD-3000RS: 3 GHz Intel Core i7*  
Recommended: 3 GHz Intel Core i7*  
   or better 

R AM Minimum: 2 GB 
With 1 DAD-3000RS: 3 GB 
With 2 DAD-3000RS: 4 GB* 
Recommended: 4 GB or more* 

Hard Dis k Minimum:   60 GB** 
Systems with 3D  
detector(s): 120 GB** 
DAD-3000RS with 15 MB / min 
max (200 Hz) rate 

Optical Drive DVD 

Dis play Minimum: 1024 x 768 resolution   
 32-bit color 
Recommended: 1280 x 1024 or 1440 x 900 
  or higher resolution 
 32-bit color 

US B  P orts  For license device: 1 port 
For connecting 
Dionex modules: 1 or more additional port(s) 
MWD-3000(RS) and  
DAD-3000(RS) Require USB 2.0 speed 

* For taking full advantage of this hardware a 64-bit Windows version is 
required. 
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** These hard disk requirements are set to enable storage of a substantial 
amount of data. The software itself requires approximately 3 GB disk space 
on the C drive (twice as much during an update). In addition, a few GB disk 
space must always be available on the C drive for Sequences cached in 
the XVault (see section 7.4.1). 

 Caution:  Please check with Thermo Fisher Scientific to 
determine any additional requirements for the instruments 
you want to connect, for example expansion slots for controlling 
third party instruments via RS-232 or GPIB.  

 

 Caution:  For running Chromeleon on 64-bit Windows, a 
computer with the “Recommended” specifications is required at 
minimum.  

 

Tip: Please contact Thermo Fisher Scientific for details about 
requirements for installing Chromeleon in a network.  
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2.4 Supported Operating Systems  
Chromeleon 7.1 SR1 has been validated for stand-alone use on 
the operating systems listed here. 

Tip: Chromeleon 7 can also be installed on server operating 
systems (Windows Server versions). Please contact Thermo 
Fisher Scientific for details. 

2.4.1 Microsoft Windows 7  
Chromeleon 7.1 SR1 was tested with 32-bit and 64-bit versions of 
Microsoft® Windows® 7 P rofes s ional and Windows 7 Ultimate 
editions.  

2.4.2 Microsoft Windows Vista  
It is possible to install and use Chromeleon 7.1 SR1 on 32-bit 
editions of Microsoft Windows Vista® B us ines s  and Windows 
Vista Ultimate; SP2 is required at minimum. However, this 
combination has NOT been formally validated, thus it is NOT 
recommended by Thermo Fisher Scientific. 

2.4.3 Microsoft Windows XP   
Chromeleon 7.1 SR1 was tested on SP3 of Microsoft Windows XP 
Professional (32-bit). It will not install on previous versions of 
Windows XP. 

2.4.4 Windows Service Packs   
For security reasons, Thermo Fisher Scientific generally 
recommends installing the latest Windows service pack on your 
operating system.  However, conflicts between Chromeleon 
releases and subsequent Windows service packs are possible. 
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 Caution:  Before installing Windows service packs different 
from those than recommended in this document, always consult 
with Thermo Fisher Scientific or check the Thermo Fisher 
Scientific web site for Dionex products 
(www.thermoscientific.com/dionex).  

Chromeleon is tested with the latest Windows service packs. 
Information and/or Chromeleon updates are provided as required. 

2.4.5 Windows Security Updates   
For optimum security, it is recommended that you keep your 
systems up to date with the latest security updates.  The risk 
that a security update itself might interfere with Chromeleon is 
generally low.  However, the update process may interfere with 
operation of Chromeleon. For example database transactions 
could be interrupted by updating SQL Server Express, and 
instrument control can be interrupted by updating related system 
components. 

 Caution:  Thermo Fisher Scientific recommends to use the 
“Download updates for me, but let me choose when to 
install them” option for automatic Windows updates and 
choosing an installation time when Chromeleon is closed and 
no data acquisition is taking place in the background. 

Notes: 
• Thermo Fisher Scientific will not formally validate Windows 

security updates. Installation and testing of security updates 
is the user’s own responsibility.  

• If you find any compatibility issue when testing a Windows 
Security Update, please contact the Thermo Fisher Scientific 
Service for Dionex Chromatography Software for support.  
Although we will make reasonable efforts to solve such 
problems, we cannot guarantee compatibility with every 
security update. 
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Security updates should generally be installed as soon as 
practicable, in order to keep the “window of vulnerability” small.  
Security updates should be briefly tested in the context of the 
laboratory’s installation and operating procedures.  Thermo Fisher 
Scientific recommends the following test procedure to ensure 
software integrity: 

• Install the security update and Chromeleon on a test PC. 

• Qualify the Chromeleon Station: Run a Chromeleon Installation 
Qualification (IQ) and a Chromeleon Operational Qualification 
(OQ).  You can start the Station Qualification from the Tools 
menu of the Console.  You can read more about Station 
Qualification in the Chromeleon 7 Help: Administrating 
Chromeleon > Station Qualification. 

• Perform further PQ tests according to the routines in your lab. 

2.5 Database Support 

2.5.1 Microsoft SQL Server Express Edition  
Chromeleon 7.1 SR1 uses Microsoft SQL Server Express Edition 
as the database engine for Standard (local) Data Vaults.  

If SQL Server Express is not already present, SQL Server 2005 
Express Edition SP3 is installed automatically during the 
Chromeleon setup, including the necessary server and client 
components and the corresponding Software Development Kit 
(SDK). This takes place before the actual Chromeleon 7 
installation starts. 

If an earlier version of SQL Server 2005 Express or if a SQL 
Server 2008 Express version is present, the SQL Server will NOT 
be updated automatically. The Chromeleon Installation 
Qualification (see section 5.3) reports the installed SQL Server 
version, and the IQReport will contain a Warning if a different 
version than SQL Server 2005 SP3 was found.   
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If desired, SP3 can be installed by starting the corresponding 
setup manually as described in section 5.6.3.3. 

Chromeleon 7.1 SR1 has been validated to work with the following 
versions of Microsoft SQL Server components: 

- SQL Server 2005 Express Edition, SP3, Version 9.3.4035.00 
- SQL Server Native Client, Version 9.00.4035.00  

Note: Chromeleon 7 has not yet been validated to work with  
SQL Server 2008 Express.  

 

Note: Chromeleon 7.1 SR1 only supports creating Standard 
Data Vaults locally on the hard drive of the PC that runs 
Chromeleon 7.  Standard Data Vaults can be shared over the 
network, but the connectivity, performance, and capacity are 
limited by SQL Server Express. 

 

Tip: Chromeleon also supports other, multi-user optimized 
databases, namely Oracle and the multi-user (non-Express) 
edition of MS SQL Server. Please contact Thermo Fisher 
Scientific for details. 

 

2.6 Required Third-Party Software  

Note: The sections below are provided for reference only.  
If not already present, the required third-party software 
components are installed automatically during the setup. The 
Chromeleon Installation Qualification (IQ, section 5.4) reports 
the status of many of these components. Should you 
experience problems with any of the third party software 
components, refer to section 5.6 for troubleshooting hints. 



Chromeleon 7 

Page 12 Installation Guide 

2.6.1 Windows Installer  
Chromeleon 7.1 SR1 requires Windows Installer version 4.5 or 
higher for the setup.  

2.6.2 Microsoft .NET Framework 
Chromeleon 7.1 SR1 requires Microsoft .NET Framework, version 
3.5 SP1. 

2.6.3 Microsoft SQL Server Express  
Chromeleon 7.1 SR1 uses Microsoft SQL Server 2005 Express 
Edition (including the Software Development Kit (SDK)) as the 
database engine for working with ‘Standard’ (local) Data Vaults.  

The validated versions of the components are: 

SP3: 
- SQL Server 2005 Express Edition, Version 9.3.4035.00 
- SQL Server Native Client, Version 9.00.4035.00  

2.6.4 Microsoft Visual C++ Redistributable  
Chromeleon 7.1 SR1 requires Microsoft Visual C++ Runtime 
Environment Version 2008 SP1. 

Some 3rd party instrument drivers require Microsoft Visual C++ 
Runtime Environment Version 2005 SP1. 

2.6.5 MSXML  
Chromeleon 7.1 SR1 requires MSXML Version 4 SP2. 

2.6.6 WibuKey Software  
Chromeleon 7.1 SR1 uses the WibuKey software version 6.00a as 
part of the software licensing infrastructure.  
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2.6.7 Amyuni PDF Converter 
Chromeleon 7.1 SR1 uses the Amyuni PDF Converter version 
4.5.1 for exporting results in PDF format. 

2.7 Software for Controlling Specific Third-
Party Instruments  

This section lists software components that are necessary for 
controlling certain third-party instruments.  

These software components are not installed automatically; they 
have to be installed manually to enable support of the 
corresponding instruments. 

2.7.1 Agilent Instrument Control Framework (ICF) and 
LC Driver Package  

This software must be installed for controlling Agilent liquid 
chromatographs from Chromeleon (it is NOT required for 
controlling Agilent GCs).   

The “Drivers” folder of the Chromeleon installation disk contains 
the ICF and LC Driver versions that were tested and were current 
at the time of releasing Chromeleon 7.1 SR1. 

The “Drivers” folder also contains a “ReadMe” file with installation 
instructions.  In addition, the “Chromeleon and Agilent ICF - Quick 
Start Guide” in the “Documents” folder provides further installation 
details, explains the basics on how to configure the systems and 
how to get started. 

The Agilent LC driver replaces the Agilent 1100 and 1200 drivers 
which are obsolete and will no longer be maintained. 

Tip: The Agilent web site provides information about which 
modules can be controlled via ICF: 
http://www.chem.agilent.com/en-US/Products/Instruments/lc/ 
Pages/specificationsicf.aspx . 

http://www.chem.agilent.com/en-US/Products/Instruments/lc/Pages/specificationsicf.aspx�
http://www.chem.agilent.com/en-US/Products/Instruments/lc/Pages/specificationsicf.aspx�
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2.7.2 Rheodyne MXII Series Valves Driver 
This software is necessary to communicate with Rheodyne MXII 
Series Valves over USB. 

The “Drivers” folder of the Chromeleon installation disk contains 
the driver version that was tested and was current at the time of 
releasing Chromeleon 7.1 SR1.   

The “Drivers” folder also contains a “readme” file with installation 
instructions. 

2.7.3 Waters Acquity UPLC System Instrument Driver  
This software must be installed for controlling Waters Acquity 
UPLC system modules. 

The “Drivers” folder of the Chromeleon installation disk contains 
the driver version that was tested and was current at the time of 
releasing Chromeleon 7.1 SR1. 

The Chromeleon Instrument Configuration Manager Help chapter 
“Installing Third-Party Modules – Waters Acquity UPLC System” 
contains installation instructions. 

Tip: The “List of Supported Instruments” in the “Documents” 
folder of the Chromeleon installation disk provides details about 
which Waters modules can be controlled from Chromeleon and 
for which of them it is necessary to install the Acquity driver. 
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3 Configuring Windows for 
Chromeleon 7 

This chapter describes how to prepare Windows for (optimal) 
operation of Chromeleon 7. 

3.1 Firewall Settings  
This section describes firewall settings used by Chromeleon. 

Tip: The (built-in) Windows Firewall is automatically 
configured during the Chromeleon installation process.  
However this only can work, if the firewall is enabled during the 
setup. Therefore make sure that the Windows Firewall is 
turned ON before you start installing Chromeleon. 

Chromeleon uses the Net.Tcp Port Sharing Service for 
communication between Chromeleon software components.  The 
Chromeleon Setup therefore starts this service and changes the 
“Startup type” to “Automatic”. 

Most Chromeleon software components use TCP Port 1325 
(which is registered with IANA for use by Dionex, see 
http://www.iana.org/assignments/port-numbers).  Port 1325 is 
added to the Exceptions list as “Chromeleon 7 Services”.  

On Windows Vista and Windows 7 the configuration enables: 
- incoming localport 1325  
- outbound remoteport 1325 
each for both Public and Domain profiles (“Firewall with advanced 
settings”): 

The following software components are also added to the 
Exceptions list: 

http://www.iana.org/assignments/port-numbers�
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Chromeleon components: 

• Chromeleon 7 Real Time Kernel  (CmDriver.exe) 

• Chromeleon 7 Device Driver Host  (CmDDKHost.exe) 

SQL Server components: 

• SQL Database Service  (sqlservr.exe) 

• SQL Browser  (sqlbrowser.exe) 

Note: Chromeleon Setup cannot configure third-party firewalls.  
These have to be configured manually as described above.  
Third-party firewalls may also cause problems during the 
installation process.  Therefore make sure that third-party 
firewalls are turned OFF before you start installing 
Chromeleon. 

3.2 Disabling Power Management 
This section describes settings that should be made on 
Chromeleon stations directly connected to instruments. 

3.2.1 Disabling Windows Power Management 
If a computer goes into Standby or Hibernate mode while the 
Chromeleon 7.0 Instrument Controller is running, then the USB 
subsystem will become unavailable.  As a result, USB-dependent 
devices (instruments and the license key) will stop functioning and 
operation is interrupted. 

Note: The default Home/Office power settings scheme of 
Windows XP SP2 would not put the computer into Standby 
mode.  However, in Windows XP SP3, Microsoft changed the 
default Home/Office power settings scheme.  The computer 
enters Standby mode after 2 hours if no mouse or keyboard 
activity is detected. 
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To disable Windows power management: 

1. From the Control Panel open the Power Options. 

2. On the Power Schemes tab select Always On. 

3. If not already done, change the Standby and Hibernate 
options to Never. 

 

3.2.2 Disabling USB Power Management 
To avoid problems during instrument control, USB specific power 
saving options must be turned off as well. 

To disable USB power management: 

1. From the Control Panel open System (Properties). 

2. On the Hardware tab click Device Manager. 

3. Expand the Universal Serial Bus Controller node. 

4. Double-click (one of) the USB Root Hub(s). 

5. On the Power Management tab clear the Allow the 
computer to turn off this device to save power option. 

6. Repeat the two steps above for all the Root Hubs. 
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4 Compatibility with Previous 
Chromeleon and PeakNet Versions 

4.1.1 Software Compatibility – Chromeleon 7 and 6 
Chromeleon 7 can co-exist with Chromeleon 6 (or PeakNet 6) on 
the same computer.  Chromeleon 7 is installed in a different folder 
and does not affect the Chromeleon 6 installation.  You can even 
use the Chromeleon 6 and 7 clients at the same time.  However, 
you cannot run the Chromeleon 6 Server and the (corresponding) 
Chromeleon 7 Instrument Controller Service in parallel. In other 
words, you cannot control instruments using the two software 
versions at the same time. 

 Caution:  When running Chromeleon 6 and 7 on the same 
computer, make sure you do NOT start the Chromeleon 6 
Server / Chromeleon 7 Instrument Controller services at the 
same time.  To avoid that this happens accidently, do NOT 
enable the options to start these services automatically.  

4.1.2 Software Compatibility – Chromeleon 7.1 SR1 
and 7.1 

When Chromeleon 7.1 SR1 is installed on a PC where 
Chromeleon 7 is present, it will replace the existing installation 
provided the AutoRun setup on the Chromeleon DVD is run. For 
details, also refer to section 5.2. Parallel installation of different 
Chromeleon 7 versions (or Service Releases) on the same PC is 
not supported. 
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4.1.3 Data Compatibility – Chromeleon 7 and 6 
Chromeleon 7 provides access to Chromeleon 6 data and 
maintains backward compatibility as much as possible.  However, 
Chromeleon 7 has been designed with focus on future 
development.  In rare scenarios this may result in minor deviations 
when looking at legacy data in Chromeleon 7. 

With Chromeleon 7, you can connect to Datasources created with 
previous Chromeleon 6 / PeakNet 6 versions.  You can view the 
data and you can even do temporary modifications and see the 
effect on the results.  However, you cannot save the changes 
inside a Chromeleon 6 Datasource.  To permanently modify data 
originating from Chromeleon 6, you must first copy the data from 
the Chromeleon 6 Datasource to a Chromeleon 7 Data Vault. 

You cannot connect to a Chromeleon 7 Data Vault from older 
Chromeleon / PeakNet versions. 

Note that Chromeleon 7 provides a new peak detection 
algorithm called ‘Cobra™’, in addition to the Chromeleon 6 peak 
detection algorithm.  If you apply the Cobra algorithm to data that 
was previously integrated with the Chromeleon 6 algorithm, the 
results may become slightly different. 

Chromeleon 7 cannot read ‘Backup’ (.cmb) files created with older 
Chromeleon / PeakNet versions, and it is not possible to export 
Chromeleon 7 data to any previous Chromeleon version.  

It is not possible to import Chromeleon 6 panels to Chromeleon 7, 
nor the other way around.  

4.1.4 Data Compatibility – Chromeleon 7.1 and 7.0 
Chromeleon 7.1 introduces new features that require updating the 
database schema of 7.0 Data Vaults. For example, it adds support 
for the UltiMate 3000 Fluorescence Detector (FLD) and System 
Suitability Testing.  Therefore, all local Data Vaults are 
automatically updated with the new database schema during the 
installation of 7.1 (remote Data Vaults can be updated by installing 
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7.1 on the remote computer).  Chromeleon 7.1 creates new Data 
Vaults with the new schema. 

4.1.5 Data Compatibility – Chromeleon 7.1 SR1 and 7.1 
Chromeleon 7.1 SR1 introduces improvements to reduce the size 
and growth of data volumes.  

Data improvements require that the database schema of 7.1 SR1 
Data Vaults be updated.  

This update prevents backward compatibility with previous 
versions. Therefore, Chromeleon 7.1 SR1 data cannot be 
transferred to Chromeleon 7.1 Data Vaults.  
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5 Installing the Software 

5.1 Do you have Chromeleon 6?  
• If you do not have Chromeleon 6, start installing Chromeleon 7. 

Follow the steps starting in section 5.2 

• If you have Chromeleon 6, read section 2.7 about compatibility, 
and decide whether you want to install Chromeleon on the same 
PC where Chromeleon 6 is running, or on a different one. 

• If you decided to use Chromeleon 7 on the same PC 
where Chromeleon 6 is running, follow section 5.2. 

• If you decided to install Chromeleon 7 on a different PC, 
but want to access your Chromeleon 6 data, follow 
section 5.2, then read section 7.4.4 about mounting 
Chromeleon 6 Datasources. 

5.2 Installing Chromeleon 7  
Follow the steps below to install Chromeleon 7.1 SR1. The steps 
are basically the same for new installations and for updating 
existing Chromeleon 6 or Chromeleon 7 installations. 

 Caution: Make sure that the person performing the 
installation has local administrator privileges in Windows! 
Otherwise, the installation will fail. 
 
If you are asked to do so, do reboot the computer. After the 
reboot, the administrator who started the setup must log in 
again so that the installation process can be completed 
correctly. 
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 Caution: Make sure that third party firewalls are turned 
OFF. 

 

Note: It is recommended to leave the (built-in) Windows 
Firewall ON. 

 

Note: Do not connect new instruments/modules via USB to 
your PC until the Chromeleon software installation is finished 
and the Chromeleon Installation Qualification (IQ) is completed 
and passed! 

 

Note: Uninstalling previous versions of Chromeleon / 
PeakNet 6 is not required before installing Chromeleon 7  

 

Note: Setup time varies depending on the presence of third-
party components. For example, installing .NET framework 
libraries may take considerable amount of time.  

1. Check chapter 2 and 3 of this document and verify that all 
requirements are met. 

2. It is best to close all applications before starting the setup 
to ensure that it can update relevant system files. 

Note that certain IT tools and anti-virus software may lock 
system files and therefore require rebooting after the setup.  
In addition, installing some of the third-party components 
(such as Windows Installer and .NET Framework) usually 
require a reboot. 

3. Start the Installation: 

Insert the installation disk into your PC.  The AutoRun 
window usually opens automatically.  

If CD Autorun is not active, or if you install from other media: 
- Run \Autorun\autorun.exe. This opens the AutoRun 
window. 
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The AutoRun window offers links for reading this Installation 
Guide, exploring the installation disk, and launching the 
installation program. 

Launch the installation program by clicking ‘Install 
Chromeleon 7.1 SR1‘, Figure 1.  

 
Figure 1: Chromeleon AutoRun window 

Alternatively, you can run \CmSetup\setup.exe. This starts 
the installation program directly. 
 

4. The Setup Wizard guides you through the installation 
procedure; follow the on-screen instructions as they appear. 

The setup starts with installing the separate "Chromeleon 7 
Shared Components" installation package which includes all 
third-party assemblies. When you install Chromeleon for the 
first time, a Windows UAC prompt asks you for consent to 
install the package. 

After installation of the Shared Components package, the 
required third-party software components ( section 2.6) are 
installed, if they are not already present.   



Chromeleon 7 

Page 24 Installation Guide 

Installation of SQL Server Express and .NET libraries can 
take 5-20 minutes; installation of Chromeleon files usually 
takes fewer than 5 minutes.  

After that, Chromeleon 7 is installed in one of the following 
folders: 

-  C:\Program Files\Dionex\Chromeleon (32-bit systems)  

- C:\Program Files (x86)\Dionex\Chromeleon\bin (64-bit 
systems).  

The Chromeleon 7.1 SR1 setup does not support changing 
the installation path. 

Note: Installation of some software components (such as the 
USB instrument drivers) may trigger a Windows security 
warning. Please continue the installation if this occurs. 

 

5. When the License Setup window appears, do one of the 
following: 

If a new blue License Key is available and the License File is 
still stored on the Key: 
- Select the Dongle option, Figure 3A.  
- Insert the License Key into a USB port of the computer 
- Wait a moment until the setup confirms that it found both 
the Key and the File and transferred the File to the computer. 
- Save a backup copy of the License File by following the 
Save license file link in the dialog. 
- Click Next, Figure 3B. 

If a License Key and a License File are both available, but 
the License File is stored on other media: 
- Select the Dongle option, Figure 3A.  
- Insert the License Key into a USB port of the computer 
- Wait a moment until the setup confirms that it found the 
Key.  
- Install the license file by following the corresponding link 
in the dialog. 
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- Save the original media with the key as a safety copy. 
- Click Next, Figure 3B. 

If either the License Key or the License File is missing, or if 
the previous procedures failed (for example, due to a 
mismatch between the key and the file): 
- Click Skip, Figure 3C.  
- You will have to provide a license after the setup has 
finished, as described in section 5.5. 

Tip: The Chromeleon Domain Controller option is for 
networked installations.  Contact Thermo Fisher Scientific to 
learn more about the advantages a networked Chromeleon 
installation may provide to your laboratory. 

6. As the final step, an Installation Qualification Report will be 
created (see section 5.3).  

 
Figure 2: Chromeleon Setup Wizard 
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A
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Figure 3: License Setup window 

You can also install Chromeleon using a command line for 
remote installation. When installing via command line, be aware 
that the Chromeleon installation consists of two packages – the 
Chromeleon7SharedComponents.msi package and the actual 
Chromeleon package – which have to be installed separately. 

Note: Make sure to install the Chromeleon7 Shared 
Components.msi package before starting the actual 
Chromeleon setup.  

The Chromeleon7SharedComponents.msi can be started from the 
Chromeleon7SharedComponents folder which is located in the 
Chromeleon CmSetup directory.  

Use the /i switch for installing the package: msiexec / i 
Chromeleon7SharedComponents.msi.  

In addition, all standard command line switches allowed for a MSI 
package may be used. 
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When updating to Chromeleon 7.1 SR1 via command line, you 
have to uninstall the previous Chromeleon installation first.  

To ensure that all Chromeleon program files are removed, it is 
recommended to use the Chromeleon Uninstaller program located 
in the following folder of the Chromeleon DVD: 
CmSetup\Chromeleon71Uninstaller\ChromeleonUninstaller.exe. 

 Caution: Do NOT run the Chromeleon 7.1 SR1 setup, if the 
Chromeleon program files are not removed completely!  

5.3 Installing Software for Controlling 
Specific Third-Party Instruments  

For controlling certain third-party instruments it is necessary to 
manually install additional software from the instrument vendor 
following the Chromeleon installation: 

• Agilent Instrument Control Framework (ICF) and LC Driver 
Package 

This software must be installed for controlling Agilent liquid 
chromatographs from Chromeleon (it is NOT required for 
controlling Agilent GCs).   

• Rheodyne MXII Series Valves Driver  

This software is necessary to communicate with Rheodyne 
MXII Series Valves over USB. 

• Waters Acquity UPLC System Instrument Driver   

This software must be installed for controlling Waters Acquity 
UPLC system modules. 

The “Drivers” folder of the Chromeleon installation disk contains 
the driver versions that were tested and were current at the time of 
releasing Chromeleon 7.1 SR1. Please refer to section 2.7 for 
further details. 
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5.4 Installation Qualification  
At the end of the installation process, Chromeleon automatically 
runs an Installation Qualification (IQ), and creates a report.  You 
can view the report by selecting the ‘Show the IQ report after 
closing the wizard’ check box (enabled by default) on the last 
page of the Setup wizard, Figure 4A.  

 
Figure 4: Last page of the Setup Wizard 

Tip: To read the report later, click Start > All Programs > 
Chromeleon 7 > Station IQ > Current IQ report.  The log file 
opens in your default web browser. 

 

Note: Your browser may display a security warning about 
‘active content’ (scripts / ActiveX controls) in the report.  This is 
caused by scripts in the IQ that can allow you to expand and 
collapse the different sections of the report for your 
convenience and better overview.  These scripts can be safely 
run, but are not mandatory; all content can be read without 
enabling the scripts. 
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The IQ compares current information about the installed files 
against a reference list supplied by Thermo Fisher Scientific.  If 
there are any differences, a Warning, or an Error message 
appears to indicate the following: 

Warning: A Warning can indicate an obvious problem that can be 
easily corrected; for example, by providing a valid license file, 
installing more RAM in the PC, or starting Windows services.  A 
Warning can also indicate that a file does not have the expected 
time stamp or version.  Usually, no action is required for minor file 
discrepancies.  If a problem occurs nevertheless, try to repair the 
installation as described in section 5.6.1.  If the problem persists, 
follow the other steps described in section 5.6 to troubleshoot the 
installation.  

Error: A vital component is missing or corrupt.  Try to repair the 
installation (see section 5.6.1).  If this does not help, follow the 
other steps provided in section 5.6 for troubleshooting. 

Note: After the initial installation of Chromeleon 7, the IQ report 
may contain a warning about a missing license, as it will if you 
clicked “Skip” in the License Setup dialog during the software 
installation (section 5.2, Figure 3C).  Follow the steps in section 
5.5 to provide a valid license. 

 

Tip: You can run the IQ at any time to check if your installation 
is intact.  To start the IQ, click Start > All Programs > 
Chromeleon 7 > Station IQ > Station IQ.  For more 
information, press F1 in the Chromeleon IQ window. 

 

Tip: All IQ Reports (and also the installation log files) can be 
easily accessed by clicking Start > All Programs > 
Chromeleon 7 > Station IQ > All IQ Reports. The physical 
location of the files is a (normally hidden) directory whose 
location depends on the operating system: 
Windows XP:   C:\Documents and Settings\All Users\ 
Application Data\   Dionex\Chromeleon\IQ 
Windows Vista / Windows 7: 
C:\ProgramData\Dionex\Chromeleon\IQ 
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5.5 Activating / Updating a License 
The license is normally activated already during the software 
installation process, as described in section 5.2.  This chapter 
describes how to: 

• Activate a license when the License Setup step was skipped 
during the software installation (Figure Figure 3C) 

• Update the license for an existing installation (for example after 
purchasing new licensed features for an existing installation) 

The processes are similar, but there is a difference depending on 
where the License File is located: 

• if a new light blue License Key containing the License File is 
used, follow Section 5.5.1. 

• if a License File is available on separate media, follow Section 
5.5.2. 

5.5.1 Using a New Chromeleon 7 License Key that 
Contains a License File 

Follow the steps below to activate or update a Chromeleon 7 
station using a light blue License Key that has never been used 
before and thus it still contains the corresponding License File. 

1. Make sure that Chromeleon 7 is already installed. 

2. Connect the License Key to a USB port of the PC where the 
license will be used. 

The Windows ‘Found New Hardware’ wizard may start at this 
point and install the necessary drivers.  

3. After a few seconds, the License File is automatically (without 
a warning) moved to the computer, in the appropriate 
location. 

4. To check the installed licenses, start the Administration 
Console: Start > All Programs > Chromeleon 7 > 
Administration Console.  
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Select the License Overview node, Figure 5A.  The Total 
column should display the appropriate number of licensed 
options, Figure 5B. 

 
Figure 5: The “License Overview” node (A) of the Administration 
Console shows the available licenses in the “Total” column (B). 

5. Back up your License File and store it in a safe location.  You 
may need it in the future, for example if you want to move the 
license to another computer, or when restoring your 
Chromeleon station after a hard disk failure. 

Section 2.1.2 describes the location where you can find the 
License File that was moved from the License Key to the 
computer. 
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5.5.2 Using an ‘Empty’ License Key and a Separate 
License File 

Follow the steps below to:  

• Activate a Chromeleon 7 station using a Chromeleon 6 (green) 
License Key, or 

• Activate a Chromeleon 7 station using a Chromeleon 7 (light 
blue) License Key that has been used before, or 

• Modify licensing for a Chromeleon 7 station, for example when a 
new License File has been received after an upgrade, or when 
moving a license to another computer. 

Note:  Make sure you have the License File that you want to 
use.  The serial number of the License File must match the 
serial number of the License Key. 

1. Connect the License Key to a USB port of the PC 
(Chromeleon 7 must be installed first). 

The Windows ‘Found New Hardware’ wizard may start at this 
point and install the necessary drivers.  

2. Open the Administration Console by clicking Start > All 
Programs > Chromeleon 7 > Administration Console, and 
select the License Manager node, Figure 6A. 

3. Click the Update License File link (Figure 6B) and browse to 
the License File you want to use.  

Select the file and click Open. The License File is copied to 
its desired location (see section 2.1.2).  
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Figure 6: License Details 

4. To check the installed licenses, select the License Overview 
node, Figure 5A.  The Total column should display the 
appropriate number of licensed options  (Figure 5B). 

5. Store your License File in a safe location. You may need it in 
the future, for example if you want to move the license to 
another computer, or when restoring your Chromeleon 
station after a hard disk failure. 
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5.6 Troubleshooting Software Installation 
1. The setup process itself checks for various conditions and 

provides useful hints/warnings for preventing installation 
issues. Therefore always observe the instructions during 
setup. For example the setup checks whether: 

• the user who started the setup has local administrator 
privileges,  

• the computer has enough RAM and hard disk capacity, 

• the Operating System requirements are fulfilled. 

Make sure that all requirements and Windows configuration 
steps described in chapters 2 and 3 are fulfilled / performed. 

2. To identify installation issues, check the IQ Report (see 
section 5.3) for Errors and Warnings. If you find Errors, try 
to repair the installation as described in section 5.6.1. 
(Remember, that you can re-run the IQ at any time.) 

3. Problems with third-party software components can 
often be resolved by reinstalling the component 
manually as described in section 5.6.3. Reading section 
5.6.2 in advance will help you understand the details of the 
installation process. 

4. If you still face installation problems, send the installation 
log files to the Thermo Fisher Scientific Service for 
Dionex Chromatography Software for support. All the 
installation log files are located in a single folder (together 
with the Station IQ Reports) that can be easily accessed via 
the Start menu: Start > All Programs > Chromeleon 7 > 
Station IQ > All IQ Reports. Some of the log files are large 
(~25 MB), but they can be compressed (zipped) efficiently. 
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5.6.1 Repairing an Installation  
Follow the instructions below to repair a Chromeleon 7 installation: 

Note:  You will need access to the Chromeleon installation 
media to repair an installation. 

1. Choose Start > Control Panel > Add or Remove Programs 
(Windows XP) or Programs and Features (Windows Vista / 
Windows 7).  

2. Select Dionex Chromeleon 7, click Change (Windows XP) 
or right-click and select Repair (Windows Vista / Windows 7). 

 Caution:  Be careful to click just once, because in Windows 
Vista and Windows 7, double-clicking an item will initiate 
removal (and not repair!) of the item. 

3. Follow the Wizard to repair the installation. 

5.6.2 Installation Process Details 
Understanding the installation process makes it easier to 
troubleshoot installation issues. 

The setup takes place in several stages: 

From the splash screen (Autorun\Autorun.exe) the main setup 
(CmSetup\setup.exe) is called. If not already present, this installs 
the following third-party software components: 

• Windows Installer (stand alone setup is available) 

• Microsoft .NET Framework (stand alone setup is available) 

• Microsoft SQL Server Express (stand alone setup is available) 

Note:  The installation process cannot be completed unless the 
above components are successfully installed. 
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After that, it calls CmSetup\CM\CmSetup.msi, which in turn 
installs the following components: 

• Microsoft Visual C++ Redistributable  
(embedded into the Chromeleon 7 setup) 

• MSXML (embedded into the Chromeleon 7 setup) 

• WibuKey Software (stand alone setup is available) 

• Amyuni PDF Converter (stand alone setup is available) 

• Chromeleon 7 

5.6.3 Manual Installation of Third-Party Software 
Components  

Chromeleon 7.1 SR1 uses certain third-party software 
components. If not already present, these are installed 
automatically during the installation process.  

If you experience problems with any of the required third-party 
software components, you can try reinstalling them manually from 
the Chromeleon 7 installation disk as described in the sections 
below. 

5.6.3.1 Windows Installer  

Chromeleon 7.1 SR1 requires Windows Installer version 4.5 or 
higher for the setup.  

The required Windows Installer version is nowadays present on 
nearly all PCs, as it is either part of the supported Windows 
version (for example Windows 7 contains Windows Installer 5.0) or 
has been rolled out as part of Windows Update (e.g. KB942288, 
KB958655).  

If the required Windows Installer version is not present, it is 
installed before the actual Chromeleon 7 installation starts.  

After installing Windows Installer, a reboot is required. 
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If you experience serious problems during the setup, you may try 
to reinstall Windows Installer from the Chromeleon 7 installation 
disk by running the appropriate installer from the 
\CmSetup\WindowsInstaller4_5\ folder. The Readme.html file in 
the folder provides further information. 

5.6.3.2 Microsoft .NET Framework 

Chromeleon 7.1 SR1 requires Microsoft .NET Framework 3.5 SP1.  

Various .NET versions are often installed on PCs nowadays. If the 
required .NET version is not already present, the necessary files 
are installed before the actual Chromeleon 7 installation starts.  

After installing .NET, a reboot may be required. 

The Chromeleon Installation Qualification (IQ) reports the installed 
.NET version(s). 

If you suspect problems with the .NET installation, you can try to 
install/repair it by running \CmSetup\DotNetFX35SP1\ 
dotNetFx35setup.exe from the Chromeleon 7 installation disk. 

5.6.3.3 Microsoft SQL Server Express Edition  

Chromeleon 7.1 SR1 uses Microsoft SQL Server Express Edition 
as the database engine for Standard (local) Data Vaults.  

If SQL Server Express is not already present, SQL Server 2005 
Express Edition SP3 is installed automatically during the 
Chromeleon setup, including the necessary server and client 
components and the corresponding Software Development Kit 
(SDK). This takes place before the actual Chromeleon 7 
installation starts. 
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Note: If an English version of SQL Server 2005 or SQL Server 
2008 is installed on a localized version of Windows XP with Service 
Pack 3 which is not English version, the following error message 
may appear:  
"The Windows Installer service cannot update the system file 
C:\WINDOWS\system32\msxml6r.dll because the file is protected 
by Windows. You may need to update your operating system for 
this program to work correctly."  
This is a known issue of the Windows SQL Server setup.  
As a workaround, click OK in the above error message to resume 
the setup. Usually, the SQL and MSXML setup will finish 
successfully and you can ignore the error. 
For details on this issue, refer to "Windows File Protection error for 
"msxml6r.dll" in setup of SQL on localized Windows XP SP3" at 
http://support.microsoft.com/kb/958897.  
For information on the available security update MS08-069 that 
resolves the issue, refer to: http://technet.microsoft.com/en-
us/security/bulletin/ms08-069. 

If an earlier version of SQL Server 2005 Express or if a SQL 
Server 2008 Express version is present, the SQL Server will NOT 
be updated automatically.  The Chromeleon Installation 
Qualification (see section 5.3) reports the installed SQL Server 
version and the IQReport will contain a Warning if a different 
version than SQL Server 2005 SP3 was found.   

In the above scenario, or if the IQ reports some other problems 
with SQL Server Express, you may try to update/reinstall it from 
the Chromeleon 7 installation disk by running 
\CmSetup\SqlExpress2005SP3\sqlexpr32.exe.  Refer to the 
Readme.html file in the same folder for further details.  Note 
however that this may affect other software using SQL Server 
Express on the same computer! 

 Caution:  Installing SQL Server 2005 Express SP3 may 
affect other software using SQL Server Express on the same 
computer! 

http://support.microsoft.com/kb/958897�
http://technet.microsoft.com/en-us/security/bulletin/ms08-069�
http://technet.microsoft.com/en-us/security/bulletin/ms08-069�
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The installation events are logged in the following location: 
C:\Program Files\Microsoft SQL Server\90\Setup Bootstrap\LOG\.  
To understand the details in the log files, refer to the Microsoft 
article "How to: View SQL Server 2005 Setup Log Files" at 
http://technet.microsoft.com/en-us/library/ms143702(SQL.90).aspx  

5.6.3.4 Microsoft Visual C++ Redistributable  

Chromeleon 7.1 SR1 requires the following versions of Microsoft 
Visual C++ Redistributable: Version 2008 SP1 and Version 2005 
SP1. 

These installations are embedded (as recommended by Microsoft) 
into the Chromeleon 7 setup.  To re-install these components, re-
run CmSetup\CM\CmSetup.msi (or the entire setup 
CmSetup\setup.exe).  The installation events are logged (together 
with other installation and qualification log files) in the IQ folder 
(see section 5.3) 

5.6.3.5 Microsoft MSXML  

Chromeleon 7.1 SR1 requires Microsoft MSXML version 4 SP2.  

This installation is embedded (as recommended by Microsoft) into 
the Chromeleon 7 setup.  To re-install this component, re-run 
CmSetup\CM\CmSetup.msi or the entire setup 
CmSetup\setup.exe.  The installation events are logged (together 
with other installation and qualification log files) in the IQ folder 
(see section 5.3). 

5.6.3.6 WibuKey Software  

Chromeleon 7.1 SR1 uses the WibuKey software version 6.00a as 
part of the software licensing infrastructure.  

The necessary files are automatically installed during the 
installation process. 

After the Chromeleon installation is complete, the CM IQ checks 
whether the WibuKey Software is properly installed. If it is not, an 
Error is issued. 

http://technet.microsoft.com/en-us/library/ms143702(SQL.90).aspx�
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If you experience problems with licensing, you may try to reinstall 
the WibuKey software from the Chromeleon 7 installation disk by 
running \CmSetup\Wibu520b\Setup32.exe. 

There is no installation log available for the WibuKey software 
setup. 

5.6.3.7 Amyuni PDF Converter 

Chromeleon 7.1 SR1 uses the Amyuni PDF Converter version 
4.5.1 for exporting results in PDF format. 

The necessary files are automatically installed during the 
installation process. 

After the Chromeleon installation is complete, the CM IQ checks 
whether the Amyuni PDF Converter is properly installed. If, for 
some reason, the Amyuni PDF Converter could not be installed, 
an Error is issued.  

In this case, the installation events are logged in a file called 
PDFInstall.log. The log file is stored (together with other 
installation and qualification log files) in the IQ folder (see section 
5.3). 
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6 Installing Dionex Instruments 
This section describes how to install chromatography instruments 
that are connected via USB to the PC.  

Chromeleon can control chromatography instruments from other 
manufacturers. (The List of Supported Instruments in the 
Documents folder of the installation disk provides an overview). 
Setup and requirements differ for each module. The Instrument 
Configuration Manager Help provides information about which 
modules are supported and how to install them. 

 Caution:  Do not connect new instruments/modules via 
USB to your PC until the Chromeleon software installation is 
finished and Chromeleon Installation Qualification (IQ) is 
completed and passed! 

To set up a system connected via USB: 

1. Connect all modules to each other and to the PC according 
to the Operating Instructions of the modules and section 6.1. 

2. Load the USB drivers for the module(s) according to section 
6.2. 

3. Add your chromatography instrument(s) to the system 
configuration using the Instrument Configuration Manager 
according to section 7.1.3. 

6.1 Connecting Modules via USB 
Most Dionex instruments are connected to the PC or to each other 
via USB. Some of them (such as detectors that acquire data at 
high rates) require USB 2.0 connections. Others can be connected 
to USB 1.1 connections as well. 

Some Dionex instruments have a built-in USB hub. The hub may 
be USB 2.0 or 1.1; it may be powered or unpowered.  
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The following guidelines must be observed when connecting 
modules via USB: 

• Modules with USB 2.0 connection must be connected directly 
to the PC (recommended for detectors) or to another module 
with a USB 2.0 hub. 

• Modules with USB 1.1 connection can be connected to 
directly to the PC or to another module with any kind of USB 
hub. 

• A powered hub continues to function when the module is 
switched off, maintaining communications for devices connected 
to the hub. 

• An unpowered hub only maintains connections while the 
device is switched on. 

The List of Supported Instruments (see Documents folder of the 
installation disk) specifies what kind of USB connection an 
instrument requires (and provides, if it has a hub). 

6.2 Loading the USB Driver for a Module 
1. Turn on the computer first, but not the module. 

2. Under the Windows operating system, log on using an 
account with local administrator privileges: 

3. Turn on the module using the main power switch. 

4. Windows Vista / Windows 7 will automatically detect the new 
module and perform the USB installation. 

Windows XP will automatically detect the new module and 
launch the Found New Hardware Wizard, which guides you 
through the USB installation. Select the following options: 

a) If asked whether Windows may connect to Windows 
Update to search for software, select No, not this time. 
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b) Accept the default option (Install the software 
automatically) and click Next>. 

c) Click Finish when the wizard reports that the software for 
the module has been installed. 

6.3 Troubleshooting USB Issues 

P roblem R emedial Action 

Windows Vista / 
Windows 7 fails to 
detect the module and 
launches a wizard 
instead 

This indicates that you connected the module 
to the computer and turned on the power for 
the first time before you installed 
Chromeleon. To resolve the problem: 
1. Click Cancel to exit the wizard. 
2. Turn off the module and unplug the 

USB cable from the computer. 
3. Install Chromeleon. 
4. Reconnect the USB cable to the 

computer and turn on the power to the 
module. Windows Vista will now detect 
the module and install the USB 
software for the module automatically. 

Windows XP fails to 
detect the module and 
a message box asks 
for a USB 
configuration file 
(CmWdmUsb.inf) 

This indicates that you connected the module 
to the computer and turned on the power for 
the first time before you installed 
Chromeleon. To resolve the problem: 
1. Click Cancel in the Windows message 

box. 
2. Turn off the module and unplug the 

USB cable from the computer. 
3. Install Chromeleon. 
4. Reconnect the USB cable to the 

computer and turn on the power to the 
module. Windows will now 
automatically detect the module and 
launch the Found New Hardware 
Wizard. 
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P roblem R emedial Action 

Chromeleon Audit Trails 
include error messages that 
indicate interruption of USB 
communications, such as: 
"Error receiving status: Error 
reading from <device name> 
@ USB <address>. The I/O 
operation has been aborted 
because of either a thread exit 
or an application request. The 
license is invalid." 
Windows Application and 
System Event Logs may 
include error messages 
related to:  
- Chromeleon 
- The disk I/O system 
- W32time 
- And other functions 

This indicates that the Instrument 
Controller PC entered Standby or 
Hibernate mode while Chromeleon 
was operating instruments / collected 
data. 
Follow sections 3.2.1 and 3.2.2 to 
disable (USB) power management. 
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7 Configuring Chromeleon 7 
This chapter describes configuration steps that are likely to be 
performed for most stand-alone Chromeleon installations. 

Note:  You need Windows (local) administrator privileges 
and/or the appropriate Chromeleon privileges to perform most 
of the tasks described in this chapter. 

 

Note: The paths mentioned in this chapter contain folders that 
are hidden by default. If you do not see them, follow instructions 
in Windows Help on how to display hidden files and folders. 

7.1 Starting Points for Configuring 
Chromeleon 7 

You can start all configuration work for Chromeleon 7.1 from two 
starting points:  

• from the Chromeleon Services Manager, which is a 
Chromeleon tool that appears minimized as the Chromeleon 
Tray Icon in the ‘Notification Area’ of the Windows Taskbar, and 

• from the Administration Console, which is a Chromeleon tool 
that can be started via the Start menu. 

7.1.1 Chromeleon Services Manager  
The Chromeleon Services Manager (the window in the top half of 
Figure 7): 

• shows the overall status of Chromeleon’s service components 
(Figure 7B), and  

• provides a starting point for instrument control related 
configuration work (Figure 7C,D,E).  
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Tip: You can read more about the Chromeleon services in the 
Glossary. 

E

C

D

A

B

C’

D’

F

 
Figure 7: Chromeleon Services Manager and Tray Icon 

The Services Manager is usually started automatically, and it 
appears minimized as the Chromeleon Tray Icon (Figure 7A) 
next to the clock in the ‘Notification Area’ (also called ‘System 
Tray’) of the Windows Taskbar.  

To open the Services Manager window, click (or right click) the 
Chromeleon Tray Icon, Figure 7A. 

If the Chromeleon Tray Icon is not present, you can start the 
Services Manager by selecting Start > All Programs > 
Chromeleon 7 > Services Manager. 

Closing the Services Manager window minimizes it again to the 
Chromeleon Tray Icon. 
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7.1.2 Chromeleon Tray Icon  
The Chromeleon Tray Icon (Figure 7A) appears next to the clock 
in the ‘Notification Area’ (also called System Tray) of the Windows 
Taskbar. It is the minimized version of the Services Manager. It 
has the following functionality: 

• It provides an easy way to open the Services Manager window 
(via a click or a right-click on the Tray Icon).  

• The Tray Icon and its tool tip (Figure 7F) show the status of the 
Instrument Controller Service. 

• Its context menu provides a shortcut for starting/stopping the 
Instrument Controller Service (Figure 7C’) and launching the 
Instrument Configuration Manager (Figure 7D’). 

If the Chromeleon Tray Icon is not present in the Notification Area, 
start it by clicking Start > All Programs > Chromeleon 7 > 
Services Manager. 

7.1.3 Chromeleon Administration Console  

The Chromeleon Administration Console 

 
Figure 8) provides the starting point for most administrative tasks 
in Chromeleon, such as: 
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• managing licenses 

• scheduling data transfer between Data Vaults, for example for 
archiving purposes 

• managing Chromeleon Users, Groups and Privileges 

• configuring “Global Policies”, for example enabling “User Mode” 

• monitoring “Discovery” that is checking which resources 
(Instruments and Data Vaults) are available in a Chromeleon 
Domain  

• managing Data Vaults installed on the Local Machine 

Tip: Some of these features are only available in a networked 
installation and are therefore not covered in this document. 
Contact your local Thermo Fisher Scientific sales organization  
for Dionex Chromatography software to learn more about the 
advantages a networked Chromeleon installation may bring to 
your laboratory 

 
Figure 8: Chromeleon Administration Console with  (A) various 

nodes in the navigation area on the left, and  (B) work area on the 
right 

To open the Chromeleon Administration Console select Start > All 
Programs > Chromeleon 7 > Administration Console. 



 Chromeleon 7 

Installation Guide Page 49 

7.2 Configuring Instruments / Modules 
After the USB software for the module has been installed (see 
section 6.1), install and configure the module in Chromeleon: 

1. Start the Instrument Controller Service either by right-clicking 
the Chromeleon Tray Icon (Figure 7A) and choosing Start 
Chromeleon Instrument Controller (Figure 7C’), or from 
the Services Manager (Figure 7C). 

The Chromeleon Tray Icon  changes to indicate that the 

Instrument Controller Service is starting . Wait until the 

Instrument Controller Service is running idle . 

If the Chromeleon Tray Icon is not on the Taskbar, click Start 
> All Programs > Chromeleon 7 > Services Manager to 
open the Services Manager and click Start Instrument 
Controller.  

2. Start the Chromeleon Instrument Configuration Manager: 

Choose Configure Instruments either after right-clicking the 
Chromeleon Tray Icon (Figure 7D’) or in the Services 
Manager (Figure 7D). 

(If the Services Manager window is open, you can now close 
it. Note that closing the Services Manager does not stop the 
Instrument Controller Service.) 

3. If necessary, click the plus sign next to the PC’s name to 
display the items underneath (Figure 9A). 

4. Select the Instrument to which the module will be assigned, 
or create a new Instrument. 

To create a new instrument, on the Edit menu, click Add 
Instrument…, or click the corresponding icon in the Toolbar, 
Figure 9B. 

5. Click Add Module on the Edit menu, or click the 
corresponding icon in the Toolbar, Figure 9C. 
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6. On the Manufacturers list (Figure 9D), click Dionex and on 
the Modules list (Figure 9E), click the module. 

7. Chromeleon connects to the module, transfers the settings 
from the module to Chromeleon, and automatically sets the 
options on the configuration dialog pages (Figure 9F) 
accordingly. Confirm the related message with OK. 

Tip: Most modules are connected via a USB interface.  The 
USB address is then used by Chromeleon to detect a module.  
The USB address typically contains the serial number of the 
module, allowing you to distinguish between modules when two 
or more identical modules are present (such as two pumps of 
the same model).  Click Browse and double-click on the USB 
number.  Only the USB addresses of corresponding modules 
are shown; for example, when adding a UV detector only the 
address(es) of the UV detector(s) are shown. 

8. On each configuration page, verify that the settings are 
correct and define additional settings if needed. For 
assistance, press F1. 

9. On the File menu, click Save Instrument Configuration, or 
click the corresponding icon in the Toolbar, Figure 9G. 

Close the Instrument Configuration Manager. 
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Figure 9: Using the Instrument Configuration Manager 

7.3 Enabling Automatic Start of the 
Instrument Controller Service  

On PCs that are physically connected to instruments (Chromeleon 
“Workstations” and “Instrument Controller Stations”), especially if 
they are controlled remotely from another PC with Chromeleon (a 
“Remote Client” station), Thermo Fisher Scientific recommends 
starting the Instrument Controller Service every time the computer 
is started.  

Tip: If the PC is not connected physically to instruments 
(Chromeleon “Data Client” and “Remote Client” stations), you 
should not follow these steps, which would result in using 
additional PC resources unnecessarily. 
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To enable automatic start of the Instrument Controller Service 

1. Open the Services Manager by clicking the Chromeleon Tray 
Icon (in the Notification Area of the taskbar), or by clicking: 
Start > All Programs > Chromeleon 7 > Services 
Manager. 

2. Select the Start service at system start check box, Figure 
7E. 

3. To start the service this time, click the Start Instrument 
Controller button in the Services Manager, Figure 7C. 

4. Close the Services Manager. 

7.4 Configuring Data Vaults  

Tip: The Chromeleon Client Online Help contains a chapter 
about Backing Up Chromeleon Data, see Chromeleon 7 Help > 
Administrating Chromeleon. 

7.4.1 Default Data Vault, XVault, and Default Location  
During the software installation, a Standard Data Vault called 
‘ChromeleonLocal’ is automatically generated (in the 
corresponding sub-folder) in the default location (see below).  

During the installation another local Data Vault (an XVault™) will 
be created.  This is a special Data Vault that stores a cached copy 
of the running Sequence.  The purpose of the XVault is to keep 
instruments running and data accessible for processing during 
network outages, but it is an essential part of stand-alone 
installations as well.  The XVault is hidden. 

Tip: The default Standard Data Vault and the XVault needs no 
configuration. 
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The default location for Standard Data Vaults is: 

Windows XP  
C:\Documents and Settings\All Users\Application Data\ 
Dionex\Chromeleon\DataVaults\<data vault name> 

Windows Vista / Windows 7  
C:\ProgramData\Dionex\Chromeleon\DataVaults\<data vault 
name> 

7.4.2 The Data Vault Manager  
The Data Vault Manager is a Chromeleon tool that helps you with 
the following tasks: 

• Creating a new Data Vault (see section 7.4.3) 
You may want to create a new Data Vault if, for example: 

• You want to have Data Vaults with and without Data Audit 
Trails / versioning, 

• You want to separate data at a high level (note that you 
can also separate data in various folders inside the same 
Data Vault, and you can specify different access 
rights/privileges for different folders),  

• You want to move (archive) some data from your “live” 
Data Vault to save space there.  

Note: The database part of a Standard Data Vault has a 4 GB 
size limit. (The database holds sample information, the 
methods, and the Audit Trails, but not the raw data).  

 

Tip: Do not create too many Data Vaults. Running Queries 
(searching for data) is more efficient if the data is not scattered 
across many different Data Vaults, because Queries can only 
work in one Data Vault at a time. 
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• Mounting a Chromeleon 6 Datasource (see section 7.4.4) 
You may want to mount Chromeleon 6 Datasources (read-only!) 
that exist locally or on the network. 

• Dismounting / Mounting a Chromeleon 7 Data Vault 
The Discovery Service finds Chromeleon 7 Data Vaults in the 
network automatically.  Manual dismounting / mounting is only 
necessary for advanced administrative tasks like moving or 
renaming a Data Vault.  These are not covered in this document.   

To start the Data Vault Manager: 

 Open the Administration Console, click the ‘Local 
Machine’ node in the navigation area (Figure 10A) then click 
Manage Data Vaults in the work area (Figure 10B). 

 Alternatively, click Start > All Programs > Chromeleon 7 > 
Data Vault Manager. 

 The Data Vault Manager opens in a separate window (Figure 
10C). 

 
Figure 10: Starting the Data Vault Manager 
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7.4.3 Creating a Standard Data Vault  
1. Start the Data Vault Manager as described above. 

2. In the Data Vault Manager window, click Create…, Figure 
10D 

3. Choose the Create standard data vault option in the Wizard 
that opens, Figure 11A.  Click Next. 

4. Enter a name for the new Data Vault, Figure 11B.  
Click Finish  

A

B

C

 
Figure 11: Creating a Standard Data Vault 
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Note: Thermo Fisher Scientific recommends keeping the default 
path (Figure 11C).  
This has the following advantages: 
- Ensures automatic protection of the Data Vault via standard 
Windows user rights. 
- Allows easy backup of all your data from a single location (see 
Chromeleon 7 Help > Administrating Chromeleon > Backing Up 
Data). 

If you create the Data Vault in another location, such as on 
another hard drive, you must take care of protecting the Data Vault 
by configuring Windows user rights like this: 

• Deny access for ordinary users,  

• Grant access for SQL Server and LocalSystem accounts.  

7.4.4 Mounting Chromeleon 6 Datasources  
If you install Chromeleon 7 on a PC where CM 6 is already 
installed, your mounted Chromeleon 6 Datasources will 
automatically become available (read only) in Chromeleon 7. For 
connecting other Chromeleon 6 Datasources, follow the steps 
below. 

To mount a Chromeleon 6 Datasource: 

1. Start the Data Vault Manager as described in section 7.4.2 

2. In the Data Vault Manager, click Chromeleon 6…, Figure 
10E 

Note: When you try to access a Chromeleon 6 Datasource 
where access control is enabled, you have to provide a valid 
Chromeleon 6 user ID and password. 

3. Click Browse… (Figure 12A) or Datasource manager… 
(Figure 12B) in the dialog that opens 

4. Follow familiar Chromeleon 6 steps 
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Figure 12: Initial steps for mounting Chromeleon 6 Datasources 

Note: Chromeleon 7 actually utilizes the same Registry keys for 
storing Datasource connection data as Chromeleon 6 does. 
- For Common Datasources: HKEY_LOCAL_MACHINE\ 
Software\Dionex\Chromeleon\Datasources\... 
- For not common Datasources: HKEY_CURRENT_USER\ 
Software\Dionex\Chromeleon\Datasources\... 
 
Consequently, when Chromeleon 6 is installed on the same PC, 
changes in Chromeleon 7 and Chromeleon 6 mutually affect 
each other. 

7.5 Enabling and Configuring User 
Management  

When User Mode is enabled, a logon is required to open 
Chromeleon. In addition, you can configure which resources (such 
as data and instruments) certain users are allowed to work with 
(Access Groups), and what they are allowed to do (Roles). 

Two basic steps are necessary to start working with User Mode: 
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1. User Mode must be enabled 

 In the Administration Console ( section 7.1.3) select the 
Global Policies node (Figure 13A). On the Security tab, 
select the User mode enabled option (Figure 13B).  
Click Save Changes (Figure 13C). 

 In the confirmation dialog, enter the credentials of a 
Chromeleon user that has the privilege to “Manage Global 
Policies” (Figure 13D). For the default credentials, see the 
Note below. 

2. User Mode must be configured 

 In the Administration Console ( section 7.1.3) expand the 
User Database node and use the sub-nodes to configure 
User Management (Figure 14A). 

 
Figure 13: Enabling User Mode 
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Figure 14: The Chromeleon Administration Console provides the 

nodes for configuring User Management 

Note: The default User Name and Password  are ‘cmadmin’ 
and ‘admin’, respectively. You should not delete the ‘cmadmin’ 
User and you should keep the ‘Full Access’ role assigned to it. 
You should change the password, write it down and store it at a 
safe location. You can then use this account for emergency 
situations, such as when ordinary administrators forget their 
passwords or lock themselves out from certain areas. 

Figure 14 shows a typical window for configuring Roles. 

Tip: To learn more about how to create user accounts, define 
Access Groups and Roles, please refer to the Administrating 
Chromeleon > User Management chapter in the Chromeleon 7 
Help. You can also access context sensitive Help pages by 
pressing F1 when working with the Administration Console. 
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Tip: There is an example user database on the installation 
disk: \Contributed Content\User Management Templates 

The user database is an encrypted XML file (UserDb.EXML). It is 
stored in the following location (neither the location nor the file 
name can be changed): 

Windows XP 
C:\Documents and Settings\All Users\ Application Data\ 
Dionex\Chromeleon\ 

Windows Vista / Windows 7 
C:\ProgramData\Dionex\Chromeleon\ 

7.6 Licensing  
The license is normally activated already during the software 
installation process, as described in section 5.2.   

Section 5.5 describes how to  

• Activate a license when the License Setup step was skipped 
during the software installation 

• Update the license for an existing installation (for example after 
purchasing new licensed features for an existing installation) 
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8 Removing Chromeleon 7 from a PC 
Removing Chromeleon from your computer consists of the 
following stages: 

• Uninstalling Chromeleon 7 

• Uninstall Chromeleon7 Shared Components 

• Uninstalling third-party software 

• Removing Chromeleon 7 data 

Note: You must log on with local administrator privileges to 
Windows  to perform some of the steps in this chapter. 

 

Note: The paths mentioned in this chapter contain folders that 
are hidden by default. If you do not see them, follow instructions 
in Windows Help on how to display hidden files and folders. 

8.1 Uninstalling Chromeleon 7 
You can remove the Chromeleon program files from your 
computer by following the instructions below.  

Tip: These steps only remove the software components. All 
your data and settings will be preserved. This has the 
advantage that you can safely uninstall the software without 
affecting your data – for example, to fix a broken installation. 

1. In the Windows Control Panel, click Add or Remove 
Programs. (Windows XP) or Programs and Features 
(Windows Vista / Windows 7). 

2. Select Chromeleon7 Shared Components from the list of 
currently installed programs and click Remove (Windows XP) 
or right-click and select Uninstall (Windows Vista / Windows 
7). 
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3. Select Dionex Chromeleon 7.1 SR1 from the list of currently 
installed programs and click Remove (Windows XP) or right-
click and select Uninstall (Windows Vista / Windows 7). 

4. Follow the on-screen instructions to remove Chromeleon 7. 

5. If the wizard asks so, reboot your computer. 

8.2 Uninstalling Third-Party Software 
Chromeleon relies on several third-party software components 
(see section 2.6), which are installed during the setup process 
(see section 5.6.2).  However, to avoid problems with software 
installed after Chromeleon, most of them are not removed 
automatically when uninstalling Chromeleon 7.  You can remove 
most of these software components manually following steps 
similar to removing Chromeleon 7 (see section 8.1). 

 Caution: The software components listed below may be 
used by various applications on your computer, not only 
Chromeleon 7. Removing them may corrupt those applications! 

The following components will not be removed by the 
Chromeleon 7 uninstall process: 

• Windows Installer 

• Microsoft .NET Framework 

• Microsoft SQL Server Express 

• WibuKey Software 

• Amyuni PDF Converter 

The uninstall process will attempt to remove the following 
components: 

• Microsoft Visual C++ Redistributable 
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• MSXML Redistributable 

These will be removed if Windows determines that they were only 
used by Chromeleon 7. 

8.3 Removing Chromeleon 7 Data  

 Caution:  The following steps will delete all locally stored 
Chromeleon data (including chromatograms, custom ePanels, 
Instrument Configuration, User Database, etc) from the PC! If 
you want to save the data, follow the steps in section 
Administrating Chromeleon > Backing Up Data of the 
Chromeleon 7 Help before you continue. 

Reboot the computer (or stop the SQL Server (SQLEXPRESS) 
service), then delete the following folder: 

Windows XP 
C:\Documents and Settings\All Users\Application Data\ 
Dionex\Chromeleon\ 

Windows Vista / Windows 7 
C:\ProgramData\Dionex\Chromeleon 

Note: If you created local Data Vaults in locations other than the 
default path, you will have to delete these separately. 
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